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PQ Analyst

Introduction
PQ Analyst increases the effectiveness of your PMCS product. It automatically generates a verity of
power and power quality reports when a problem is detected. It can also be schedules to generate
the same reports on a periodic basis. These automated reports include a complete artificial
intelligence based executive level report as well as a group of descriptive charts and graphs that
allows you to quickly identify and solve power related problems. This proactive reporting process is a
major advancement over existing systems that require a manual review of data to spot problems.

PQ Analyst is designed to be simple to setup. For each power-monitoring device, the user is shown a
list of available jobs. The user then selects the jobs they want to run and under what condition. A user
can schedule a job, such as a Sag Frequency Chart,  to run periodically,  say, once a month, or when
a power measurement parameter exceeds a user selectable threshold. Reports can be emailed or
even placed on a user's web site. Users also have the ability to be paged or alarmed when a power
problem occurs.

PQ Analyst is integrated seamlessly into PMCS and Waveform Analyst. Setup is minimal. During
setup, PQ Analyst automatically becomes "aware" of all PMCS waveform-recording devices and
keeps the list of devices current as new waveform recording devices are added to PMCS.  Users can
quickly view reports for any device as well as have the complete flexibility of charting the raw data
using Waveform Analyst.

It is planned that new job and report types will be continuously added to PQ Analyst. The objective is
to proactively identify problems to allow you to lower your costs and improve facility reliability.

Operation

Menu Reference – Operate
The Operate menu contains the following items: Start, Stop, Save Log, Clear Log, and Exit.
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Operate Menu - Start

Select this to start the scheduler whenever it has been stopped.  The ‘stoplight’ button on the toolbar
will ‘pop up’ to indicate that the scheduler is running, and a message will be added to the scheduler
log.

Operate Menu – Stop
Select this to temporarily stop the scheduler.  Any job that is currently running will be allowed to finish.
Any job that is in a ‘retry loop’ will exit the retry loop.

To indicate that the scheduler has stopped, the ‘stoplight’ button on the toolbar will remain ‘pressed’,
and a message will be added to the scheduler log.

You can use ‘Operate’ ‘Stop’ to temporarily stop the scheduler so that you can avoid ‘locking’ issues
when editing device and/or job properties.
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Operate Menu - Save Log

Use this to save the current scheduler log to a text file.

Operate Menu - Clear Log

Use this to clear the current scheduler log.  You will be prompted to save the log before clearing.  If
you do not want to save the log, you may press ‘No’.  Pressing ‘Yes’ saves the log to a text file that
you choose.  Pressing ‘Cancel’ exits and does not clear the log.

Operate Menu - Exit

Use this to end PQ Analyst.  If there are any running jobs, PQ Analyst will wait for them to complete.

You will also be presented with a dialog box that will allow you to stop any running jobs before they
complete, if any jobs are in progress.  You should ONLY do this if there is a problem that requires you
to immediately end these jobs.  You should be aware that stopping a job before it completes could
create problems with the databases that would be extremely difficult to repair.
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Menu Reference – Setup
The Operate menu contains the following items: System, Devices, and Jobs.

Setup Menu - System
Selecting this menu first prompts you to shut down the scheduler.  You should choose ‘Yes’ to stop all
running jobs, and completely shut down the scheduler, if you plan on changing any system
information.  If you only want to view the system information, you do not need to shut down the
scheduler.  However, changes to system information while jobs are running could result in serious
problems and loss of data.

You will be supplied with a dialog box similar to this one:
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DB Version: Indicates the current database version (read-only)
COMM Drive: The drive on which the device ‘raw’ data is stored.  This is normally “C:\”
PQ Drive: The drive on which the report and graph data is stored.  This is normally “C:\”
PQ Root Path: The ‘root path’ for the data file storage.  This is normally
“GE_PMCS\PQAnalyst\Data”.
The ‘root path’ is assembled along with the ‘PQ Drive’ or ‘COMM Drive’ (as appropriate) to form the
fully qualified path for the associated data files.
FTP Server: The ‘ftp server’ for uploading report files.  If you do not have one, you should leave this
blank.  Otherwise it’s an IP address or URL.
FTP Root: The ‘root path’ on the FTP Server.  Typically this will be an ‘upload root’, such as
‘/FTPUpload’, where users have write access.  This will also be the initial directory when connecting
to the FTP server.
FTP PQ Path: This duplicates the functionality of the ‘PQ Root Path’.  The ‘FTP Root’ is assembled
along with the ‘FTP PQ Path’ to form an absolute path on the FTP server.
FTP User: The user name for logging on to the FTP server.  This user must have write access to the
path specified above.
FTP Password: The password associated with the user name specified above.
MAIL Profile: For sending e-mail, this is the ‘MAPI Profile’.  If you are using Outlook Express, you
should select the ‘mail account’ name from the ‘accounts’ list (use ‘Tools’ ‘Accounts’ from Outlook
Express, and select the ‘Mail’ tab to view them).
Mail PW: If required, the password needed to access the MAIL profile.
Mail ‘From’: The FROM address for e-mail.  Typically this will be in a format similar to:

“Your Name”yourname@yourdomain.com
If you specify a name that is already in the address book associated with the MAIL Profile, the
remaining information should be automatically filled in for you when the e-mail is sent.
Site Server IP: This is the IP address for the ‘WFA Server’, for remote access to the device (or ‘site’)
data.  If you are not running WFA Server, you should leave this blank.  If you specify a Site Server IP

mailto:yourname@yourdomain.com
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address, this information will be used to create ‘.wfr’ analysis files that can be uploaded to an FTP
server and used by remote clients to view the device’s event and waveform data remotely.

Setup Menu - Devices

When you select ‘Setup Devices’ you are presented with a list of the currently known devices.  New
devices are automatically added to the PQAnalyst System database by the ‘COMPIMP’ service
whenever data from the new device has been made available by the PMCS system.  PQ Analyst
displays a ‘snapshot’ of these known devices.
Once you select a device, you will be presented with the following property sheet:

Description:  This is the device name obtained from the COMTRADE file.  You can
change this to a new description that better represents what the device is measuring,
for example “Main Panel” or “Number 4 Milker”.
Device Dir: This is normally assigned a unique value when the device is added to
the system.  You can change this if you like, but you should be certain that it does not
conflict with any other devices.  It normally follows the pattern of ‘DEVnnnn’ where
‘nnnn’ is equal to the device’s unique ‘Site Equipment ID’ from the PQAnalyst System
database.
Circuit Type: This will typically be “3 PHASE WYE CIRCUIT” or “3 PHASE DELTA
CIRCUIT” (or similar).  This value is initially assigned from information in the
COMTRADE files when the device is added to the database.  If you need to change
it, you can select one of the circuit types from the ‘combo box’.
Nom Voltage: This is the ‘nominal voltage’ of the circuit being measured by the
monitoring device.  This value is used in reports for scaling purposes and for limits
calculations. It is automatically assigned to a “best value” when the device is first
added to the database.  However, you may find it necessary to adjust this to the
actual nominal value for the circuit.  Typical values are 120, 277, 480, 12000.
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Nom Current: This is the ‘nominal current’ for the circuit being measured by the monitoring device.  If
there is no known nominal current, you can leave this blank or enter ‘0’.  The ‘nominal current’ is
typically used for limits calculations and in reports for scaling purposes only.
Apply Limits/Nominals:  This uses the nominal voltage and nominal current that you enter, and
applies the changes to the entire circuit being measured.  It also calculates several limits for you,
based upon these nominal values.
OK / Apply / Cancel: These buttons allow you to save changes, or cancel and close the property
sheet without saving any changes.  Pressing ‘OK’ automatically saves changes, and closes the dialog
box.  Pressing ‘Apply’ commits any changes immediately, but leaves the property sheet open.
Pressing ‘cancel’ discards any changes since the last ‘Apply’ and closes the dialog box.

Setup Menu - Jobs

When you select ‘Setup Jobs’ you are presented with a list of the currently known devices.  New
devices are automatically added to the PQAnalyst System database by the ‘COMPIMP’ service
whenever data from the new device has been made available by the PMCS system.  PQ Analyst
displays a ‘snapshot’ of these known devices.
Once you select a device, you will be presented with the following property sheet:

Device Directory:  This is normally assigned a unique value when the device is added to the system.
You can change this if you like, but you should be certain that it does not conflict with any other
devices.  It normally follows the pattern of ‘DEVnnnn’ where ‘nnnn’ is equal to the device’s unique
‘Site Equipment ID’ from the PQAnalyst System database.
STOP ALL: checking this box stops ALL jobs for this device
Active Jobs List: This is a list of active jobs for the device.  The descriptions that you see here
match the description that you assign to the job when you create it.  By default the description
matches the job type.  However, you can give it a more meaningful description, such as “Carol’s
Report” or “Monthly Summary”.
Available Job Types: You can add a new job by selecting one of the items in the ‘Available Job
Types’ list, then pressing ‘Add’.
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‘Add’ button: Adds an item from the ‘Available Job Types’ list, and automatically opens the ‘Job
Properties’ dialog box so that you can edit the job’s properties before saving it.
‘Edit’ button: Opens the Job Properties dialog box for the job selected in the ‘Active Jobs List’.
‘Remove’ button: Removes the job selected in the ‘Active Jobs List’.
OK / Apply / Cancel: These buttons allow you to save changes, or cancel and close the property
sheet without saving any changes.  Pressing ‘OK’ automatically saves changes, and closes the dialog
box.  Pressing ‘Apply’ commits any changes immediately, but leaves the property sheet open.
Pressing ‘cancel’ disgards any changes since the last ‘Apply’ and closes the dialog box.

Whenever you edit a job, a dialog box similar to this will appear:

Description: Typically this will match the job type from the ‘Available Job Types’ list.  However, you
can assign your own description, such as “Carol’s Report”, or “Month-End Summary”.
Job Type:  Read-only job type from the ‘Available Job Types’ list.
Next Event: the next date/time on which this job will run.  Initially this value is blank, which implies
that it will run immediately unless you use a ‘trigger’ (or ‘alarm’) to schedule it.
Frequency: This indicates how often the job will run.  You can select a pre-defined frequency,  such
as monthly, quarterly, annually, or a ‘user-defined’ frequency, which is in minutes.  The default is 240
minutes.
You can also select ‘trigger’ as the frequency.  In this case, a value that exceeds the settings for the
specified “trigger type” will cause the job to run.
Trigger Type: Only active if you select ‘trigger’ as the job’s frequency.  A typical ‘trigger type’ might
be RMS VOLTS.  If one of the phase’s RMS voltage were to exceed the high or low limits, a ‘trigger’
would be generated that would cause this job to run.
Low / High Limit: Enter the limits here for the ‘trigger type’ you selected.  If you leave an entry blank,
no limit will apply for that item.
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E-MAIL RECIPIENT: If you elect to e-mail a report, this entry contains the e-mail address list.
Separate each entry with a ‘;’.  The e-mail addresses should take the form of “Recipient
Name”<recipient@domain.com> or simply ‘recipient@domain.com’.  Quote marks should be used on
the recipient name whenever it is specified in addition to the e-mail address.
Disposition: When multiple ‘dispositions’ are possible, you will see a list that includes checkboxes
labeled FTP, e-mail, and so-on.  If you check the ‘FTP’ box, the reports will be sent to the default FTP
server as specified in the System settings.  If you check the ‘e-mail’ box, the reports will be sent via e-
mail to the addresses specified in the ‘E-MAIL RECIPIENT’ box.
Optional Message: On many reports, especially those that can be e-mailed, the ‘optional message
text’ appears on the e-mail.
OK / Apply / Cancel: These buttons allow you to save changes, or cancel and close the property
sheet without saving any changes.  Pressing ‘OK’ automatically saves changes, and closes the dialog
box.  Pressing ‘Apply’ commits any changes immediately, but leaves the property sheet open.
Pressing ‘cancel’ discards any changes since the last ‘Apply’ and closes the dialog box.
Stop Scheduling: By checking this box, you can temporarily stop this job from being scheduled.
This may be required if a device stops producing data, or if you do not want to alter the existing report
files until some outside event has taken place (such as a meeting or an audit of some kind).
Schedule Now: By checking this box, you can force a job to run immediately.  The schedule will be
updated only if the current date/time follows the next scheduled date/time.
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Menu Reference – View

The View menu contains the following items: Toolbar, Status Bar, Reports, Graph, and Refresh.

View Menu - Toolbar

Selecting this shows the tool bar.  A check box will appear next to the menu whenever the tool bar is
visible.

View Menu - Status Bar
Selecting this shows the status bar.  A check box will appear next to the menu whenever the status
bar is visible.

View Menu - Reports

Selecting ‘Reports’ first prompts you with a list of monitoring devices.  If you select a device, PQ
Analyst will open an ‘explorer’ window in the “history” directory where the report files are located.
From here you can view the files directly by double-clicking their icons in the ‘explorer’ window.
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View Menu - Graph

Selecting ‘graphs’ first prompts you with a list of monitoring devices.  If you select a device, PQ
Analyst will open Waveform Analyst for the selected device, with month to date data pre-selected for
you.  As well, the device’s entry will remain locked until you close Waveform Analyst.  This is the
safest way to view a device’s data while PQ Analyst is running.

View Menu - Refresh

Selecting ‘refresh’ forces the scheduler log display to refresh itself.
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Menu Reference - Help
About PQ Analyst – displays a dialog box indicating the current version of PQ Analyst and copyright
information.
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PQ Analyst - Troubleshooting

Troubleshooting
If you experience any problems with PQ Analyst, there are several probable causes that you
should investigate yourself before seeking technical support.

A. PQ Analyst can’t open the ‘PQAnalyst System’ Data Source
a) Most likely this is due to a problem with the ODBC configuration.
b) From the ‘Start Menu’, select ‘RUN’ and ‘ODBCAD32’
c) From the ODBC Administrator, select the ‘System DSN’ tab
d) Check for the presence of ‘PQAnalyst System’ and ‘PQAnalyst Data’

If these data sources are missing, you will need to re-add them.  Use ‘Add’ to re-add these
data sources.  By default they will use the ‘MS Access 97 Database’ driver, and the two
‘.mdb’ files will be located in C:\GE_PMCS\PQAnalyst\Data.
Additionally, you should make sure that nobody is trying to access this database using a
database client application such as Microsoft Access.  Such applications often “lock” the
database and prevent anyone else from opening it.  If an application were to ‘lock’ the
database, PQ Analyst would not be able to open its system database and it would give you
an error similar to the one you get if the database does not exist.

B. I keep getting an error message similar to ‘Unable to get equipment info’
Again, this is most likely due to a problem with the ODBC configuration.  In this case, it would
be the ‘PQAnalyst Data’ data source that is affected.  You should make sure that the
‘PQAnalyst Data’ data source is properly configured using the ODBC Administrator (see
above), that the ‘PQAData.mdb’ file is present in the PQAnalyst ‘data’ directory (by default,
C:\GE_PMCS\PQAnalyst\Data ) and that nobody has attempted to open this ‘.mdb’ file with a
database client application such as Microsoft Access while PQ Analyst is trying to access it.
It is also possible to get this error message if there is a problem with the database.  If you
believe that this is the case, you can try using the ‘Setup Devices’ menu to view the device
properties, and correct any problems.

C. Ai*Power will not run a report (the log says “no IDX file” or a similar message), and
it is the first day of the month.
Sometimes at the beginning of a month there will be no data for Ai*Power to report on, and its
output files will not be generated.  This is most likely caused by a device that has not
generated any data yet for the current month.  To solve this problem, you can manually
trigger the device to generate a new set of data, or set the reporting time and frequency so
that this condition is avoided.

D. The report was scheduled to be e-mailed, but the report was not attached to the e-
mail that was actually sent.
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This can happen when a ‘Simple MAPI’ client OTHER than Outlook Express has been
chosen.  ‘Microsoft Outlook’ handles its attachments differently, and other mail clients may
not be able to read them.  To avoid this problem, open the ‘Outlook Express’ application on
the machine that is running PQ Analyst, and select ‘Tools’ ‘Options’, and make sure there is a
check in the box labeled “Make Outlook Express my default Simple MAPI Client” (this should
be located on the ‘General’ tab).

E. Adobe PDF Writer just prompted me for a file name.  What do I do?
This is a known problem with the PDF Writer.  You should select an output file the first time
this shows up and press ‘OK’, then re-run the same job after it completes so that the data is
written to the correct output file.  Normally it will only happen one time after installing the PDF
Writer.  If you continue to get prompted for an output file name, you should try re-installing the
PDF Writer.

In all cases, if you experience any problems that you cannot readily solve and you believe
you need technical assistance, you should do the following BEFORE contacting anyone for
outside technical support:

1. Make sure you know the version of PQ Analyst that you have installed.  You can
determine this by selecting the ’Help’ ‘About PQ Analyst’ menu and writing down the
version number.

2. Note the type and number of devices you have installed with the PMCS system.
3. Note the version of Windows you are running, and any applicable service packs that

are installed.  You can get this information by opening ‘Explorer’, then selecting ‘Help’
‘About’.

4. Indicate which services are running (PMCS2FTF, COMIMP, WFASrv).
5. Make sure that the ODBC data sources for ‘PQAnalyst System’ and ‘PQAnalyst Data’

are properly configured, and that no other process (on the current machine or across
the network) is attempting to access the database files exclusively.

6. Try to reproduce the problem.  If you are successful, please record the exact steps you
used to create the problem, and any error messages or message boxes that you
encounter.  Screen captures can also be useful, but are far less helpful than a simple
transcription of an error message along with the steps to reproduce it.
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Waveform Analyst

Introduction
Waveform Analyst is a powerful graphing and charting software application to view and analyze large
quantities of power measurement data in the OPEN database. Waveform Analyst allows a user to
quickly identify and evaluate power problems or to generate executive level trend and summary
reports.

Waveform Analyst can be used to evaluate all channels from a single monitor or selected channels of
any group of monitors. Up to any combination of eight channels can be displayed simultaneously. For
viewing more channels multiple instances of Waveform Analyst can be launched.

Waveform Analyst has a suite of informative charts and graphs. New charts will be added regularly.
Chart types include those for standard time plots, CBEMA, ITIC, sag frequency, harmonic distribution,
and energy analysis.

Waveform Analyst is a desktop application. A web enabled version, Waveform Analyst Server with its
corresponding client application, Waveform Analyst Remote, is discussed at the end of this chapter.

A powerful feature of Waveform Analyst is its dynamic interaction of the multi widow interface. The
three windows, or PANES, allow a user to quickly identify data of interest and to jump to the
associated waveforms or detail that describe the event. Waveforms can be dynamically changed to
phasors or harmonics by a click of the mouse.

Once these events of interest have been identified they may be manually analyzed or fed directly into
an artificially intelligent sister application, Ai*Power, which will perform additional data filtering, data
analysis and report generation. The following is a typical example of how this Three Pane Browser
appears when viewing an RMS time-plot, along with the waveforms associated with it.
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Overview - Features
Waveform Analyst offers many features that are designed for ease of use

1. Interactive Windows allow jumping between analysis summaries and individual events

2. Scrolling and Zooming capability

3. Automatic circuit parameter calculations from waveform data

4. Data Filtering

5. Output to Ai*Power for detailed power quality analysis

6. FTF and PQDIF file transfer formats for transferring data

7. ODBC client, compatible with standard database engines

8. RMS Time Plots, CBEMA, ITIC, SAG Frequency, THD Histogram, Unbalance Histogram,
Energy, Demand, and Waveform plots.

9. ‘All Channel All Parameter’ calculations ‘on the fly’ for any given set of events and/or
waveforms.

10. Printing and Exporting of screen output into a number of standard formats, including text files,
bitmaps, and windows metafiles.
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Waveform Analyst - Operation

Quick Start (to view data from a single device)

Launch Waveform Analyst. From the File menu select New Analysis. A list of devices should be displayed

as shown in Figure X. This group of devices represents those that recorded power waveform data. If a list

of devices is not displayed then it may be due to the fact that your PMCS has not collected waveform

data since the installation of Waveform Analyst on your PMCS server. Waveform Analyst will create new

device locations on the fly as they are added to your PMCS system. The names automatically given are

the unique identifiers given by PMCS. Select the device you want and click ADD.
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The main setup tabbed dialog box will appear with each channel mapped to a user defined
description. You may change the user-defined description to any 32 character alphanumeric
string. Click OK.
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The Waveform Analyst's 3 Pane Browser will appear showing a time plot of the device's channels in
the left most Pane. Follow the instructions described later in this section to change chart types and
time date ranges. If you receive a message that there is no data for the time date selected right
mouse click anywhere on the screen to display the main setup tabbed dialog box. Select Filter tabbed
dialog box and increase the time date range until data is displayed.
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Using three basic actions the user can unleash the power of Waveform Analyst.
1) Zooming
In either Pane A or B, left click and drag the mouse, then click on

the Magnifier button to zoom in on the time plot or the waveform.

2) Double Click a point in the Pane A Summary Chart

The summary charts normally shown in Pane A are a composite of waveform events that occurred
over a period of time. By double clicking a point in the summary chart, the waveform that resulted in
that point will be shown in Pane B.

3) Left Mouse Click any Pane To Change the Chart Type
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Each Pane can be displayed in a number of charting formats. To change the chart type, left mouse
click and make your selection.
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Main Menu – Introduction

There are two different menus in WAVEFORM ANALYST.  The first menu (no open analysis) is
shown whenever there are no analyses open.  The second, and full menu, is made available
whenever an analysis is open.

The toolbar and menu bar of a program are very important components.  They allow the functions of
the program to be accessed and used with ease.

The menu bar is the fundamental interface for any program and its functions will be explained first.

The toolbar allows you to maximize your use of the program with short easy steps and the buttons
will be displayed next.

• Menu (no open analysis)

• Menu (at least one open analysis)
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Main Menu (no open analysis)
The following menu choices are displayed when there is currently no analysis open.

File
View
Utility
Help

File Menu (no open analysis)
The File option allows you to create a new database, re-initialize an existing database, create or open
an analysis, set the default printer settings, or exit the program.

Related Topics:

Database New
Database Initialize
New Analysis
Open Analysis
Print Setup...
Exit
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Database New
Creates a new, empty O.P.E.N. database and initializes it for use by Waveform Analyst.

To create a new database:

1. From the ‘File’ menu, select ‘Database New’.

2. Choose an appropriate ‘.mdb’ file name and press OK.

3. The new database will be created.

Shortcut: Ctrl+N.

Database Initialize
Note: Use this with extreme care.  Initializing a database destroys any data stored within that
database!
Initializes (or re-initializes) an existing database as an O.P.E.N. database, and initializes it for use by
Waveform Analyst.

To initialize (or re-initialize) an existing database:

1. From the ‘File’ menu, select ‘Database Initialize’

2. The standard ODBC data source dialog box will appear.  Select the desired data source from
the list (you can also use the standard ODBC dialog to create a new data source at this time).

3. The database will be initialized (or re-initialized) and any existing O.P.E.N. data will be
erased.  New tables will be created to support O.P.E.N. and ‘master tables’ will be filled with
the standard values.

New Analysis (no currently open analysis)
Creates a new Analysis in a 3 Pane Browser window.

To create a new analysis:

1. From the File menu, select ‘New Analysis’.  In the stand-alone version, if there is no
“PQAnalyst Data” data source defined, the ‘Database Open’ dialog box will appear.
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In the remote version, a similar dialog box will appear only if multiple databases have been
assigned to the remote server.  Otherwise, the default database will be selected for you, and you
will immediately be presented with the ‘Node Selection’ dialog box (see item 3,below).

2. Select one of the data sources listed in the ‘Database Open’ dialog box.  If the data source
needs additional information to open the database, the ODBC driver will prompt you.
NOTE:  If you want to open an Access ‘.mdb’ file, use the ‘MS Access’ data source, and
specify the ‘.mdb’ file name when prompted.

3. Once the database has been successfully opened, the ‘Node Selection’ dialog box will
appear.

NOTE:  In the left-hand section is a list of “top level” circuit descriptor nodes, known as “Measurement
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Points”.  Each of these is associated with a particular circuit, or “Measurement Point”.  Associated
with the “Measurement Point” is a set of ‘channels’ for the monitoring device (or ‘analyzer’).  On the
right hand side is a list of the desired ‘measurement nodes’ (nodes that collect events) – these will be
used to ‘filter out’ all of the events that you are interested in looking at.

4. Select the desired nodes as follows:

a) highlight the desired circuit in the left-hand list
b) Press the ‘Add’ button to add all nodes related to this circuit.
You can also select individual nodes from a circuit by first double-clicking the item in the left-hand
list to display the individual measurement nodes, then select the nodes you want and press the
‘Add’ button for each.

5. If desired, you can adjust the date/time range as displayed in the lower right corner.
Waveform Analyst automatically assigns them to the maximum range of events stored for the
selected nodes.  If you want a narrower date/time range, you can assign it at this time.

6. Press ‘OK’ to select the nodes.  This will display the ‘Properties’ dialog box, where you can
make additional changes before Waveform Analyst queries the database.

7. Pressing ‘OK’ on the ‘Properties’ dialog box will complete the selection process, and
Waveform Analyst will collect and display the data.  You can then use ‘Site Save’ to save the
analysis information in a disk file, so that it can be viewed later.
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Open Analysis
Opens an existing analysis file (‘.aib’ for the stand-alone version, or ‘.rbr’ for the remote version).

To open an existing analysis:

1. From the ‘File’ menu, select ‘Site Open’.

2. You will be presented with a standard Windows ‘File Open’ dialog box.  The filter will
be pre-selected to open files of the proper type.  Using this ‘File Open’ dialog box,
select the desired analysis file.

3. Press the OK button.

Print Setup

Shows a listbox with standard Windows printing options.  You are able to change the
default printer as well as specify options that will affect the layout of the paper and printer.
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Exit
Exits WAVEFORM ANALYST.

Toolbar button:   
Figure 1

View (no open analysis)
Toolbar
Status bar
Toolbar Options

ToolbarOptions.33Toolbar
Enables or disables the toolbar.  When checked, the toolbar is visible directly under the
menu.  When unchecked, the toolbar will be hidden from the WAVEFORM ANALYST main
window.

Status Bar
Enables or disables the status bar.  When checked, the status bar is visible at the bottom of
the WAVEFORM ANALYST main window and status messages will be seen and displayed
during the use of the program.  When unchecked, the status bar will be hidden and no status
messages will be visible from the main window.

Toolbar Options
This menu bar option brings up a dialog box that allows customization of the toolbar.
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Please see Configuring the toolbar for information on how to configure the toolbar.

Utility

Import
Export
Re-Index Events
Re-Index Waveforms
Re-Init Master Tables
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Import
Waveform Analyst allows you to import data from either ‘FTF’ (proprietary text file) format, or from
PQDIF (Electrotek standard interchange format).  Use the ‘Utility’ ‘Import’ drop-down menu to select
the import type.

For FTF, you can import Waveforms, Events, or ‘All’.  ‘All’ includes both Waveform and Event FTF
data, and optionally includes the ‘configuration’ file, which will create a new node configuration if the
associated equipment does not already have node and equipment information in the selected
database.

For PQDIF, you can select a single PQDIF file.  Each PQDIF file imports to the database using the
‘Default PQ Nodes’.  It is best to begin with an empty database (see ‘Database New’), and when
prompted to create the default PQ Nodes, select ‘Yes’.  Then, select ‘Import’ ‘PQDIF’, and choose the
new database (when prompted), and finally the PQDIF file (which has an extension of ‘.pqd’).
Waveform Analyst will map the PQDIF file’s channels as appropriate to the default PQ Nodes.

Once data has been imported, you can use either ‘Site New’ or ‘Site Open’ to view the data.

Export
Waveform Analyst allows you to export data into PQDIF format.  Export with no site open will export
all nodes and event/waveform data from the database without any filtering.  This could result in an
extremely large PQDIF file that 3rd party software packages might have trouble analyzing.

To filter the data for export, you should create a new analysis (or open an existing one) using either
‘Site New’ or ‘Site Open’, then select a date/time range with the cursors and use ‘Utility’ ‘Export’ from
the open analysis.

Re-Index Events
At times it may become necessary to re-index event data in the O.P.E.N. database.  Use this menu option to

re-build all of the Event indices.  If the database is being imported to frequently, this could correct data-related

problems and make queries a lot faster.
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Re-Index Waveforms
At times it may become necessary to re-index waveform data in the O.P.E.N. database.  Use this

menu option to re-build all of the Waveform indices.  If the database is being imported to frequently,

this could correct data-related problems and make queries a lot faster.

Re-Init Master Tables
Re-initializing the master tables is usually necessary ONLY if you have upgraded Waveform Analyst

with a newer version.  By re-initializing the master tables of an existing O.P.E.N. database, you will be

refreshing it with the latest event, trigger condition, node type, and similar data.  As the product

evolves, it may be necessary at times to re-initialize master tables in existing databases in order to

take advantage of the new features.

To re-initialize the master tables of an existing database, select ‘Utility’ ‘Re-Init Master Tables’, then select the appropriate data
source.  For an Access ‘.mdb’ file, you can use ‘MS Access 97 Database’ – the ODBC driver will prompt you for the file name.
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Help
The following menu items are available under ‘Help’:

Contents: Displays the Waveform Analyst help ‘Contents’ (Finder) window
Search for Help On: Context-sensitive help
Index: Displays the Waveform Analyst help index
Using Help: Help on using Windows Help
Technical Support: Provides information on Technical Support.
About Waveform Analyst: Displays a dialog box showing version and copyright information for the
Waveform Analyst application.
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Main Menu (at least one open analysis)
The following options are for the menu when at least one analysis is open.

File
Edit
View
Settings
Utility
Window
Help

Figure 2
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File Menu (at least one open analysis)
New Analysis
Open Analysis
Close Analysis
Print
Print Preview
Print Setup...
Exit

New Analysis (at least one open analysis)
Creates a new Analysis in a new 3 Pane Browser window.

To create a new analysis:

1. From the File menu, select ‘New Analysis’.  In the stand-alone version, if there is no
“PQAnalyst Data” data source defined, the ‘Database Open’ dialog box will appear.

2. In the remote version, a similar dialog box will appear only if multiple databases have been
assigned to the remote server.  Otherwise, the default database will be selected for you, and you
will immediately be presented with the ‘Node Selection’ dialog box (see item 3,below).

3. Select one of the data sources listed in the ‘Database Open’ dialog box.  If the data source
needs additional information to open the database, the ODBC driver will prompt you.
NOTE:  If you want to open an Access ‘.mdb’ file, use the ‘MS Access 97 Database’ data source,
and specify the ‘.mdb’ file name when prompted.
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4. Once the database has been successfully opened, the ‘Node Selection’ dialog box will appear.

NOTE:  In the left-hand section is a list of “top level” circuit descriptor nodes, known as “Measurement
Points”.  Each of these is associated with a particular circuit, or “Measurement Point”.  Associated
with the “Measurement Point” is a set of ‘channels’ for the monitoring device (or ‘analyzer’).  On the
right hand side is a list of the desired ‘measurement nodes’ (nodes that collect events) – these will be
used to ‘filter out’ all of the events that you are interested in looking at.

4. Select the desired nodes as follows:
a) highlight the desired circuit in the left-hand list
b) Press the ‘Add’ button to add all nodes related to this circuit.
You can also select individual nodes from a circuit by first double-clicking the item in the left-hand
list to display the individual measurement nodes, then select the nodes you want and press the
‘Add’ button for each.

5. If desired, you can adjust the date/time range as displayed in the lower right corner.  Waveform
Analyst automatically assigns them to the maximum range of events stored for the selected
nodes.  If you want a narrower date/time range, you can assign it at this time.

6. Press ‘OK’ to select the nodes.  This will display the ‘Properties’ dialog box, where you can
make additional changes before Waveform Analyst queries the database.
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7. Pressing ‘OK’ on the ‘Properties’ dialog box will complete the selection process, and
Waveform Analyst will collect and display the data.  You can then use ‘Site Save’ to save the
analysis information in a disk file, so that it can be viewed later.

Toolbar button:  
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Open Analysis (at least one analysis already open)
Opens an existing analysis file (‘.aib’ for the stand-alone version, or ‘.rbr’ for the remote version).

To open an existing analysis:

1. From the ‘File’ menu, select ‘Site Open’.

2. You will be presented with a standard Windows ‘File Open’ dialog box.  The filter will
be pre-selected to open files of the proper type.  Using this ‘File Open’ dialog box,
select the desired analysis file.

3. Press the OK button.

Toolbar button:  

Close Analysis
Closes the currently active analysis.

Toolbar button:  
Figure 3

Print
Prints the active view.  The active pane will be printed.

Shortcut: Ctrl+P.

Toolbar button:  
Figure 4

Print Preview
Print previews the active pane.  Shows the printed page on screen with margins, headers, footers,
and graphics.

Toolbar button:   
Figure 5



PQ Analyst User’s Guide ••••  43

Print Setup

Figure 6

Shows a listbox with standard Windows printing options.  You are able to change the default printer
as well as specify options that will affect the layout of the paper and printer.

Exit
Closes any open analysis and exits Waveform Analyst.

Toolbar button:   
Figure 7



PQ Analyst User’s Guide 44

Edit
Copy
Save To File

SaveToFile.60Edit - Copy
Copies the contents of the selected window to the clipboard.  If the data being viewed is in ‘listbox’ or
‘text’ form, the data on the clipboard will be ANSI text.  Listbox data will be tab-delimited for easy
insertion into a spreadsheet or word processor.  If the data being viewed is a graph, the data on the
clipboard will either be a bitmap with the same dimensions as the current screen resolution, or a
metafile, depending on the selection in the Screen Tabbed dialog box.  Please see Screen for more
information.

Toolbar button:  

Edit - Save To File
Saves the data in the selected pane as either a 256-color bitmap or a tabbed delimited text file
depending upon the settings of the pane.  Pane "A" is saved as a 256-color bitmap when the pane is
in chart mode.  If the pane is in list mode, the file is saved as a text file.

Toolbar button:   

NOTE:  A 256-color bitmap was chosen in order to preserve color integrity while at the same time
ensuring compatibility on a wide variety of platforms.
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View (at least one open analysis)
Previous Event
Next Event
Jump Back
Jump Forward
Active Pane as Chart or List
Grid Lines
Zoom In
Zoom Out
Expand to Cursors
Show Detail
Toolbar
Status bar
All Events
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View - Previous Event
Steps to the previous event.

Toolbar button:   

View - Next Event
Steps to next event.

Toolbar button:   

View - Jump Back
Jumps back a group of events.

Toolbar button:   

View - Jump Forward
Jumps forward a group of events.

Toolbar button:   

View - Active Pane as Chart or List
This selection allows the user to alternate between list mode and graph mode for a specific pane.
When the option is checked, the information in the specific pane is displayed in list mode, which
shows all the data with exact values displayed.  When the option is unchecked, the information is
displayed in graph mode with data points shown in a graphical display.

Note: This option is available in Pane A and Pane B only

Toolbar button:   
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View - Grid Lines
This option, when checked, enables the grid lines for the active pane and when unchecked disables
the grid lines.

Note: This option is only available if the specific view is in chart mode.

Toolbar button:   

View - Zoom In
When in chart mode it is possible to view a portion of the chart in more detail than the rest of the
chart.  This enables more detailed readings of some points that may not be clear when viewing the
chart as a whole.

Note: This option is only available once a box has been drawn with the cursor.

Toolbar button:   

View - Zoom Out
When in chart mode it is possible to get the whole picture of the chart instead of a small portion.  This
option expands the chart to its original un-zoomed state.

Note: This option is only available when the chart has been previously zoomed in.

Toolbar button:   

View - Expand to Cursors
When the cursors are used, this option zooms in to whatever is between the cursors.

Toolbar button:   
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View - Show Detail
Depending upon the current view, a detail window will be created, containing information about the
current selection.

For an event in Pane A, the following dialog box is displayed:

Figure 8

For a waveform in Pane B, the following window is created:
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Figure 9

This window also allows you to see individual data points in ‘Listbox Mode’.

For ‘List of Event’ data in Pane C, the following window is created:

Figure 10

The type and style of report visible in this window depends entirely upon the data currently being displayed in Pane

‘C’.  The report attempts to correlate the data from Pane C in a meaningful fashion.
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View - Toolbar
Enables or disables the toolbar.  This enables the user to add more space to their screen by
removing the buttons on the top of their screen.  When this option has a check mark next to it, the
toolbar is enabled and can be viewed in the WAVEFORM ANALYST main window.  When the option
is unchecked, the toolbar is hidden, more space for the program is available, and the toolbar may not
be used.

View - Status bar
Enables or disables the status bar.  When checked, the status bar can be viewed at the bottom of the
WAVEFORM ANALYST main window.  When the option is unchecked, the status bar is hidden, more
space for the program is made available, and no status messages are displayed.

View - All Events
Displays all events within a certain time/date range.

When checked, all events within the range are shown, and when unchecked, only the events that
satisfy the current settings in the Tabbed Dialog Boxes will be shown.

To set the time/date range

• Type the start date and time of the first event you wish to see included in the list.

• Type the end Date and time of the last event you wish to see included in the list.

Note: All Events will display all the events inclusive of the first and last events.
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Settings
Analysis Options
Toolbar Options
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Settings - Analysis Options
This opens the SETTINGS tabbed dialog box, as seen below:

Figure 11

For more information on the settings tabbed dialog box, please see Settings.
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Settings - Toolbar Options
This opens the Toolbar Setup dialog box that allows you to customize the toolbar.

For more information on customizing the toolbar, see Configuring the Tool Bar.
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Utility
Export
Re-Init Master Tables
Ai*Power
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Utility – Export
This allows you to export the data for the current analysis, filtered by the date/time range of the
cursors, to a PQDIF file for analysis by 3rd party applications.

To export the data into PQDIF:
1. Enclose your data between the two vertical cursors in Pane A.  (For more information on

Pane A please see Pane A.)
2. Select ‘Utility’ ‘Export’ ‘PQDIF’ from the main menu
3. When prompted, select an output file (default extension ‘.pqd’)

Waveform Analyst will then create a PQDIF file using the selected nodes, for events and

waveforms with date/time values between the cursors in Pane A.

Utility - Re-Init Master Tables
This will re-initialize the standard values for the ‘master tables’ in the database.  For ‘legacy’

databases that may have outdated information in the master tables, you can update them with the

updated values for the most recent version of Waveform Analyst. This may become necessary

whenever new trigger conditions, new measurement parameters, new equipment types, and so on

are added to Waveform Analyst’s capabilities.  Legacy databases that have not been updated may

not display these new parameters correctly in the list boxes and on the graphs.  To correct this

problem, you can use ‘Re-Init Master Tables’ to re-initialize the master tables with the new values.

Any customized ‘master table’ entries (such as those created by a device driver) that do not fall within
the range of ‘Reserved’ values will not be affected.
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Utility - Ai*Power
Note: If you do not have Ai*Power installed on your system, or you have a version that is not
compatible with WAVEFORM ANALYST, this menu option and the button associated with it will be
grayed out. This function of WAVEFORM ANALYST allows data to be analyzed by Ai*Power.

To Analyze Data with Ai*Power

• Enclose your data between the two vertical cursors in Pane A.  (For more information on
Pane A please see Pane A.)

• Click on the Ai*Power icon or choose Ai*Power from the menu.

• Ai*Power will launch and begin the process of importing the data then Analyzing the data.
(Please see the Ai*Power manual for more information.)

Note: The data you will analyze with Ai*Power is located in Pane A.  The range of events
analyzed in Pane A are those on or between the vertical cursors. You may zoom in on a select
group of events in Pane A then have Ai*Power analyze them.
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Window
New Window
Cascade
Tile
Arrange Icons
Auto Size Pane
Save Pane Ratio
Toggle Split Method
Window List
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New Window
When selected, this option brings up the SETTINGS tab in the tabbed dialog box for the purpose of
configuring the data to be displayed in the new window.  Once the options have been chosen, a new
Three Pane Browser will be created based upon the options you select.

In this way you can compare two separate displays for the same analysis by placing them into two
different windows (Ex: RMS Plot in one window, CBEMA in the other).

Toolbar button:   

Cascade
Places the currently open windows in the standard overlapping fashion.

Toolbar button:   

Tile
Places the currently open windows in the standard side-by-side fashion.

Toolbar button:   

Arrange Icons
When there are multiple Three Pane Browsers open and they are minimized to the WAVEFORM
ANALYST main window, this option arranges the icons in the standard side-by-side fashion.

Auto Size Pane
This option auto sizes the active Three Pane Browser to a standard size where all windows are
visible.

Toolbar options:   

Save Pane Ratio
Saves the current state of the pane for the next time Auto Size Panes is used.
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Window - Toggle Split Method

By selecting this menu item you instruct the 3 Pane Browser to switch between ‘split methods’.  The
default ‘split method’ puts Pane A on the left, Pane B in the upper right, and Pane C in the lower right
section, as below:

The alternate ‘split method’ places Pane C below Pane A, and Pane B takes up the entire right-hand side, as below:
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Window List
The window list (located below the other menu items) shows all active windows and allows them to be
selected individually.
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Help Menu
The following menu items are available under ‘Help’:

Contents: Displays the Waveform Analyst help ‘Contents’ (Finder) window
Search for Help On: Context-sensitive help
Index: Displays the Waveform Analyst help index
Using Help: Help on using Windows Help
Technical Support: Provides information on Technical Support.
About Waveform Analyst : Displays a dialog box showing version and copyright information for
the Waveform Analyst application.
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Configuring the Toolbar
To configure the Toolbar, select ‘Toolbar Options’ from the ‘View’ menu.  The following dialog box will appear:

To display a particular button on the toolbar, check the box next to its bitmap in the list.  You may also display large

buttons in lieu of small buttons (see ‘button size’).  The default settings only display a subset of the buttons, to

accommodate smaller display sizes.  Pressing ‘OK’ saves your changes to the ‘default’ settings file located in the

same directory as the Waveform Analyst application.

Related Topics:
Toolbar Button List
Button Size
Tool Tips
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Toolbar Button List
The Toolbar Button List can be modified to include or exclude any or all toolbar buttons.  You may
select those that you feel are more helpful to you or those you use most frequently.

All available buttons are listed below:

Button Function

New Analysis

Open Analysis

Save Analysis

Save Analysis As

Close Analysis

Ai*Power

Print

Print Preview

Save to file

Exit

Undo

Delete

Edit Copy

Jump back multiple events

Previous Event

Expand to Cursors

Next Event

Jump forward multiple events

Active Pane as Chart or List

View Grid Lines

Zoom in
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Zoom out

Preferences

Filter Events

Window New

Window Cascade

Window Tile Horizontal

Auto Size Panes
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Button Size
The button size can be modified to give you larger buttons on your screen.  You may choose large or
small buttons depending upon your preference by activating either the ‘small buttons’ or ‘large
buttons’ setting under ‘Button Size’ (in the upper right corner on the dialog box shown below).

Example:

Small button 

Large Button 

Tool Tips
The Tool Tips are small windows that provide quick help to explain the functions of the toolbars.
They may be turned on or off here.  Tool Tips activates itself when the mouse cursor is placed over a
specific button on the toolbar.
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Three Pane Browser

Introduction

The Three Pane Browser is used to view the data in WAVEFORM ANALYST.  This tool has many
functions for viewing the data such as chart mode and list mode, and it also has many shortcuts to let
you get things done quickly.  These and many other functions of the Three Pane Browser will be
introduced in the following sections.

For more information, select one of the links below:

Layout

Pane A

Pane B

Pane C
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3 Pane Browser - Layout
The Three Pane Browser was given its name because its three main components are window panes
and they are used to display and obtain information for the user.  In this text, the three panes will be
referred to as:

Pane A (Left Pane)

 Pane B (Upper Right Pane)

c. Pane C (Lower Right Pane)
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NOTE:  In the ‘alternate split method’ Pane A is the upper left pane, Pane B is the right-hand pane,
and Pane C is the lower left pane.  You can switch between the ‘split methods’ using the ‘Window’
‘Toggle Split Method’ menu.  For more information on this, see Toggle Split Method.

Each pane has its own functions and personality, and they all work together to allow you to browse
the data in three different ways at the same time.
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3 Pane Browser - Pane A
Introduction
Chart Mode
List Mode
Event Detail
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Pane A - Introduction
Pane A is the main window in the Three Pane Browser.  It not only shows the timeplot of the selected
events, but also displays the events over a pre-selected (if desired) period of time.  Pane A shows the
events in two modes: either chart mode or list mode.  Chart mode displays the graph of the events
where list mode displays the events as stored in the database.
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Pane A - Chart Mode
The first notable point in chart mode is the chart itself.  The chart displays the event value on the left
side (corresponding to the Y axis) and the Event date/time on the bottom (corresponding to the X
axis).

The figure below shows the plot of the events over time:

Related Topics:
Popup Menu
Zoom
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Pane A Chart Mode - Popup Menu
There are many shortcuts in WAVEFORM ANALYST and the popup menu is one of them.  This small
menu has much of the functionality of the full menu, but it is made for convenience and easy use.

To access the menu, place the cursor anywhere in Pane A and click on the right mouse button.  You
will see a small menu that is similar to the one located on the figure below:

Show Detail:  Clicking on the show detail button brings up the event detail dialog box with specific
details about the event located within.

Zoom In:  Contracts view of chart

Zoom out:  Expands view of chart

Expand To Cursors:  When the cursors enclose a portion of the chart and Expand to Cursors is
selected, the chart will be expanded in on that portion of the chart that was in-between the
cursors

Edit Pane Options:  Brings up the tabbed dialog box with Pane 'A' as the tab of choice.  This enables
options for this specific pane to be chosen.  For more information, please see Pane 'A' Config.

List Box Mode: Puts the pane into list box mode.  Please see List Mode for more information on list
box mode.
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Pane A Chart Mode - Zoom
Another feature of WAVEFORM ANALYST is the ability to zoom in on any portion of the chart you
select.  There are two ways to do this:

Create a box around the portion of the chart you wish to zoom in.

Choose zoom in from the menu, toolbar, or popup menu.

or

Drag the bar on each side of the window to enclose the portion of the chart that you wish to zoom in.

Choose expand to cursors from the menu, toolbar, or popup menu.

Pane A - List Mode
List mode gives detailed information on each event that is displayed in chart mode.   Each pane is
either a list of events or the details of a specific event.

The "Active Pane as List" menu selection presents the list of numerical event information in that pane
that was used to create the graph.

In Pane A, the events listed will only be those chosen in the settings menus for Pane A.  Detailed
information about each event can be easily displayed by double clicking on the event line or by
selecting the ‘View’ ‘Show Detail’ menu.
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Pane A - Event Detail
In addition to viewing the event information in Pane A using List Mode, it is possible to double click on
any single event and view the information of a single event in a report like form.
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3 Pane Browser - Pane B
Introduction
Chart Mode



PQ Analyst User’s Guide ••••  77

Pane B - Introduction
Pane B shares many of the same functions as Pane A although the data displayed is very different.
While Pane A displays event data over a period of time, Pane B displays waveform data associated
with a particular event or groups of events that were recorded in succession.

Pane B - Chart Mode
Chart mode in Pane B displays the event waveform values on the left side (corresponding to the Y
axis) and the event waveform date/time on the bottom (corresponding to the X axis).

Related Topics:
Popup Menu
Zoom
List Mode
Event Detail

Pane B - Chart Mode - Popup Menu
The popup menu in Pane B has the same look and feel of the popup menu in Pane A, but the Edit
Pane Options choice is different.

Show Detail:  Clicking on the show detail button brings up the event detail dialog box with specific
details about the event located within.

Zoom In: Contracts the view of chart.

Zoom out: Expands the view of chart.

Expand To Cursors:  When the bars enclose a portion of the graph and this is selected, the graph
will be zoomed in on that portion of the graph that was in-between the bars.

Edit Pane Options:  Brings up the tabbed dialog box with Pane 'B' as the tab of choice.  This enables
options for this specific pane to be chosen.  For more information, please see Pane B.

List Box Mode: Puts the pane into list box mode.  For more information on List Box Mode, Please
see List Mode.

To access the popup menu, place the cursor anywhere in Pane B and click on the right mouse
button.  You will see a small menu that is similar to the one located below pop up on your screen and
present you with some options:
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Pane B Chart Mode - Zoom
Another feature of WAVEFORM ANALYST is the ability to zoom in on any portion of the graph you
select.  There are two ways to do this:

Create a box around the portion of the graph you wish to zoom in.

Choose zoom in from the menu, toolbar, or popup menu.

or

Drag the bar on each side of the window to enclose the portion of the graph that you wish to zoom in.

Choose expand to cursors from the menu, toolbar, or popup menu.

Pane B Chart Mode - List Mode
List mode gives detailed information on each waveform that is present in the database.  Each pane is
either a list of events (from the database) or a list of specific information about a group of events
(events that have been filtered).

However, what the user often sees is a graph of the events created by the pane object.  The "Active
Pane as List" menu selection presents the list of numerical event information in that pane that was
used to create the graph.
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Pane B Chart Mode - Event Detail
In addition to viewing the event information in Pane B using Chart Mode, it is possible to double click
on any single waveform event and view the single cycle corresponding to the selected list entry (or
point on the graph).
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3 Pane Browser - Pane C
Pane C can display ‘All Channels All Parameters’ information, or an ‘Event List’ corresponding to all
events for the current date/time selected in Pane A.

The following shows the ‘All Channels All Parameters’ display in Pane C:

The following shows the ‘Event List’ in Pane C:
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Pane C shows a mini report is produced when an event is selected and double clicked in Pane C.
The report describes the event with the information that can be seen in the figure below.
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The Settings Tabbed Dialog Box
The SETTINGS tabbed dialog box assigns the specific options that relate to the Three Pane Browser,
and the data filters for extracting information from the O.P.E.N. database.

There are seven tabs in the settings tabbed dialog box:

Channel

Screen

Event Filter

Wiring Config

Pane 'A' Config

Pane 'B' Config

Pane 'C' Config
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Settings - Channels

Introduction
The channels tab enables you to select or deselect the channels to display.

Node Selection
This section allows you to select up to 8 nodes from the list of nodes for this analysis.(as
defined when the analysis was created) by its description.  Each entry must contain a
different node.
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User-Defined Description
Here you may enter your own description for each node in the ‘edit box’ to the right of the
corresponding node selected in the ‘Node Selection’ column.  The description you enter here will
appear on all charts and in all reports and list boxes in Waveform Analyst.  This enables you to
customize the charts to your own specifications.
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Settings - Screen

Jump Back/Forward To... Group Buttons
Event Type
By choosing event type, the Jump Back/Forward To group buttons will jump to this type of event.

The options are:

• Crest Factor

• Current THD

• Demand

• Energy

• Frequency

• Harmonics Current

• Harmonics Volts

• Harmonics Watts

• Peak Current

• Power Factor

• RMS Current
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• RMS Volts

• Transformer K-Factor

• Transients Current

• Transients Voltage

• Unbalance

• Voltage THD

• Volts-Amps

• Volts-Amps-Reactive

• Watts

Ex:

If RMS CURRENT was chosen in the "Jump Back/Forward area", and the button is checked, the next
time you press either the Jump Back button or the Jump Forward button (see margin), WAVEFORM
ANALYST will search for the next RMS current event.

'n' items
Jumps back/forward 'n' events where 'n' is a number from 1 to 1000.

Period of Time (seconds)
By selecting the unit time, the forward and reverse buttons move that amount of time forward or that
amount of time backward and brings up the next event at the end of that period of time.

Next Event with Waveform
By selecting the next event with waveform, the forward and reverse (multiple event buttons) will move
you to the next event with a waveform.

Status Dialogs
Enables or disables the displaying of informational dialog boxes throughout the program.

8. � Enabled

9. � Disabled

Fonts / Colors
Graph Background Color
The Graph Background Color may be selected here by pressing the button to the left of the color
(default is white).

Select List Box Font
This option brings up the font dialog box that allows you to select the type of font that will be
displayed in the List boxes throughout WAVEFORM ANALYST.

Copy to Clipboard
This area allows you to select how the chart will be copied to the clipboard when using the copy
function.
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• Bitmap

• Metafile

Settings - Event Filter

Event Date/Time Range
This section of the event filter tab allows the user to specify the start and end time/date for the data
displayed.  The starting dates are in the left columns, and the starting times in the right columns.  A
value of ‘NULL’ indicates that no filtering will take place.

Calculated Events
Include ‘Calc Totals’ Node:
When checked, the “Include ‘Calc Totals’ Node” checkbox indicates to Waveform Analyst that the
‘Calc Totals’ node should appear in the list of available nodes for Pane ‘A’.  Selecting the ‘Calc Totals’
node allows you to calculate ‘Phase Totals’ event values using waveform and event data in lieu of
using the actual ‘Phase Totals’ node.
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Use Waveform Data:
When checked, any parameter NOT available in the various Event tables for a given date and time
can be automatically calculated from Waveform data by Waveform Analyst.  This results in a much
slower query, but more complete data.
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Steady-State Histograms
Timed Events Only:
When checked, only those events and waveforms with a trigger condition of ‘TIMED’ will be
considered in producing steady-state histograms.  Specifically, this affects the THD Histogram and
the Unbalance histogram.  The purpose of this feature is to allow you to eliminate ‘exceedence’
events from histograms that are supposed to represent steady-state conditions.
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Settings - Wiring Config

Introduction
The Wiring Config tab lets you assign specific nodes to ‘phases’ within a particular wiring
configuration.  When the wiring configuration is already known from the relationships between the
nodes in the O.P.E.N. database, this information is filled in for you when you first create an analysis.
If Waveform Analyst cannot determine the correct node assignments, you can make those
assignments here.

Wiring Config
The ‘Wiring Config’ display, and the corresponding ‘combo box’ below, allows you to select a wiring
configuration and view a visual representation of the circuit.  In the example above, a WYE
configuration has been selected.  Note the visual representation showing phases A, B, and C, and the
Neutral (N) and Ground (G) connections to the common (center) connection of the WYE
transformers.
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Node Selection
These 8 ‘combo boxes’ allow you to choose a node that corresponds to the Phase values.  The
‘Voltage’ and ‘Current’ nodes indicate which nodes will have Voltage events, and which ones will
have Current events.  For a WYE circuit (as well as SINGLE PHASE and SPLIT PHASE), they can be
the same, if the monitoring device records both voltage and current data on the same node.  For a
DELTA circuit, the ‘Voltage’ node will have phase to phase values, while the ‘Current’ node will have
phase values.

Phase Totals
The ‘Phase Ttls’ combo box allows you to select the node that contains “phase total” data (also
known as ABC or ‘Circuit Totals’).  “Phase Total” data will consist of a summation of all 3 phases,
such as “Total Watts” (as with a revenue power meter).

In all cases with node selections, if there is no node that corresponds to that portion of the circuit, you
can select ‘N/A’.
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Settings - Pane 'A' Config

Introduction
The Pane 'A' Config tab enables you to select a name for the channels, select a color for the
channel, a symbol (if in CBEMA mode) and the type of parameter that you wish assigned to that
specific channel.

Description
The description drop down box enables you to select the label for the data that you want to see in
Pane A.

The options for the description are dependent upon what is entered in the Channel Descriptors
section of the Channels tab.  Please see Channels.
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Color
The type of color that you desire to see for that specific channel may be chosen from a standard
Windows color dialog box.  To select, press the button directly to the right of the color in the Pane A
tab.

Symbol
The symbol is used only for CBEMA mode and it marks the location of the data point on the chart.  To
select a symbol, press the button to the right of the box with a line.  This will bring up the following
dialog box

Parameter Assignment
This selection is the data type that you will be viewing for the specific chart number.
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Chart Arrangement
There are two options in the Chart Arrangement

10. 1.  Stacked

11. 2. Overlaid

When Stacked is selected, the charts are stacked one on top of the other which enables you to see
multiple charts at once.

When overlaid is selected, each chart overlays the other and they can only be seen one at a time.

Note:  The number beside the heading "number of charts" corresponds to the number of channels
selected in the Channels tab.

Chart Type
Time Plot
Shows a plot of all the data that is in the site.  What is shown is dependent upon the date and time
ranges that you specify in the site open dialog box or in the Event Filter Tab Dialog Box.

CBEMA
Shows a standard CBEMA plot of the data: number of cycles vs. nominal voltage.

ITIC (CBEMA)
Shows an ITIC CBEMA plot of the data using a different set of limits: number of cycles vs. nominal
voltage.

SAG Frequency
This displays the frequency of SAG events over time by severity, using a histogram.

THD Histogram
This displays the frequency of THD by severity, using a histogram.  The values are calculated from
waveforms if no THD events are present in the event tables.

Unbal Histogram
This displays the frequency of Voltage Unbalance by severity, using a histogram.  The values are
calculated from waveforms and RMS events if no Unbalance events are present in the event tables.

Energy
This displays an ‘Energy Plot’ showing averaged 15 minute intervals for energy over time.

Demand
This displays a ‘Demand Plot’ showing the total demand over time.
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Settings - Pane 'B' Config

Introduction
The Pane 'B' Config tab enables you to select a name for the channels, select a color for the channel,
how to arrange the charts, and the type of chart.

Description
The description is where you want to label the type of voltage or current that you wish to see on the
chart.  These choices correspond to the channels activated in the Channels tab for current.
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Color
The type of color that you desire to see for that specific channel may be chosen from the standard
Windows color dialog box.  This may be selected by pressing the button directly to the right of the
color you wish to change.

Chart Arrangement
There are two options in the Chart Arrangement

• Stacked

• Overlaid

When Stacked is selected, the charts are stacked one on top of the other which enables you to see
multiple charts at once.  This has an advantage of enabling you to see  even more data at once.

When overlaid is selected, each chart overlays the other and they can be seen one at a time.

Note:  The number beside the heading "number of charts" corresponds to the number of
charts selected.
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Chart Type
Waveform
Displays the waveform associated with the current event (if any).

Harmonic Distribution
Graphically presents a Fourier analysis of the waveform event.  The vertical bars represent the value
of the 1st to the 50th harmonic.  The numeric values, as well as their phase angles may be displayed
in Pane C.  To access numbers up to the 50th harmonic, double click on an item in Pane C to view
the Single Pane Browser (Pane D).

Pane D contains all 50 harmonics as well as their number, value, and phase.

Harmonic Dist % of RMS
Graphically presents the distribution of the harmonics as related to the RMS.  The percentile

Harmonic Dist % of Fund
Graphically presents the distribution of the harmonics as related to the fundamental.

Phasors
Graphically presents relationship of the angles at the zero crossing, with respect to each other, on an
overlaid chart showing their amplitude and phase angle.

Note: If you wish to view phasors while in scope mode, you need to select phasors before you
enter scope mode.
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Settings - Pane 'C' Config

View Style

Pane C shows either single events, status events, or an all channel all parameter table depending
upon the selection.

• Selecting Single Event shows all events occurring for the time/date of the cursor position in
Pane A.

• Selecting the second option (Status Events) allows you to see status events for that site
beginning with the left cursor in Pane A and ending with the right cursor.

• Selecting All Channels All Parameters allows you to view a table of a series of event
parameters for each active channel including totals.  Table values are taken directly from the
database or computed from waveforms if they are available.  This table is generated for
values that occurred at the time/date of the left cursor in Pane A.

For ‘All Channel All Parameters’ the ‘harmonic #’ determines which harmonic will be used for
harmonic voltage and other related calculations where a harmonic number is required.



PQ Analyst User’s Guide ••••  99

Waveform Analyst Server

Waveform Analyst Server

The Waveform Analyst Server can be used in conjunction with the Waveform Analyst Remote
application to provide the full suite of Waveform Analyst functions to users who are on a network
external to where the waveform data is stored. Waveform Analyst Server is installed with every
installation, but must be configured via the Windows Service Control Manager if the user wishes for
the service to start with Windows.

Configuring Waveform Analyst Server

Waveform Analyst Server is automatically configured when it is installed.

The startup property for the service is set to ‘manual’. In order to run Waveform Analyst server every
time Windows boots, use the Windows Service Control Manager and set the startup property to
‘automatic’. To run Waveform Analyst Server for a single session of Windows, use the start menu
selection ‘Start Waveform Analyst Server’.

Waveform Analyst Server gets its data from the ‘PQAnalyst Data’ DSN created by either the
PQAnalyst or Waveform Analyst setup program.
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Waveform Analyst Remote

Waveform Analyst Remote
Waveform Analyst Remote is the client side of Waveform Analyst Server. Its interface is identical to
that of Waveform Analyst, save for the method by which the user accesses the data.

Browsing Data with Waveform Analyst Remote
From the File menu, choose New Analysis. The Remote Server Name dialog should appear:

Enter the IP address, URL, or in the case of a LAN, the network name of the computer running
Waveform Analyst Server and click [OK]. The Device Selection dialog should appear. From this
point, the interface is the same as the standalone version of Waveform Analyst. Consult the
Waveform Analyst documentation for instructions.
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Manual Mapping Application - CTRADCFG.EXE

CTRADCFG.EXE allows the user to configure two aspects of the PMCS2FTF translation service. The
first is to configure the FTP function that allows the service to automatically transfer translated files to
a remote server. The second is to manually map the circuit type and channel designations of a new
PMCS device where the device's Comtrade files cannot be automatically deciphered by the
Waveform Analyst. This mapping information is stored in the services cache file.

Configuring FTP

To enable or disable PMCS2FTF’s FTP functionality, check or uncheck the Enable FTP checkbox in
the FTP Configuration section of the CTRADCFG.EXE dialog. If FTP is enabled, the corresponding
textboxes will become active, allowing for user input. Enter the server’s IP address or DNS in the
Server field. Enter the entire upload path (starting at the root) in the Upload Path field. Enter the
account login in the Username field, and the corresponding password in the Password field. FTP is
disabled by default.
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Editing Device Mapping
PMCS2FTF should be able to automatically determine most Comtrade file's circuit configuration and channel
designations. However, in some cases a new device's Comtrade file will not supply sufficient information to
allow the service, PMCS2FTF, to decipher the configuration. In these cases, the user must use
CTRADCFG.EXE to manually select the circuit type and channel designations. CTRADCFG.EXE will then
update the service's cache file and will cause all existing Comtrade files of that device to be immediately
translated.

In order to edit a device's entry in PMCS2FTF’s device cache file; first select the device from the Device
Name list box. Use the checkbox below the Device Name list box to toggle whether or not all devices should
be visible for editing, or just devices that the service has not been able to decipher. In the former case,
undeciphered devices are marked with an ‘*’, whereas deciphered devices have no such denotation.

Once a device has been selected, any information that PMCS2FTF has determined regarding the device is
displayed in the fields and list boxes outside of the FTP Configuration box.

For a device to be considered valid it’s circuit type (WYE, DELTA, etc.), nominal voltage, and at least one
COMTRADE channel to one OPEN channel must be mapped.

The circuit type can be selected via the Circuit Type list box. Numeric circuit information such as nominal
values and limit values can be entered in the appropriate textboxes Nominal Voltage, Nominal Current,
Max Current and Min Power Factor.

Mapping COMTRADE channels to OPEN channels can be accomplished using the two columns of list boxes
on the dialog, labeled COMTRADE Channels and OPEN Channels. Simply select the COMTRADE channel
one wishes to map, and select the appropriate OPEN channel in the list box across from it. There must be a
one-to-one correspondence in the mapping of COMTRADE to OPEN channels. CTRADCFG.EXE will alert
the user if an entry has been omitted or if an illegal mapping has been entered.

When a device has been satisfactorily mapped, click the [Commit] button to update the device map in
memory. If [Commit] is not clicked, and another device is selected for editing, the changes made to the
previous device will not persist. When all devices have been satisfactorily edited and had their changes
committed, click the [Save] button to save the changes to PMCS2FTF’s device cache file. Click [Exit] to exit
the application without saving the changes to the device's mapping in the service's cache file.
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Appendix A: Technical Support

For additional technical support, please contact GE Industrial Systems.  Please refer to the GE PMCS
documentation for customer support contact information.

Start-up difficulties
If you are experiencing START-UP difficulties with WAVEFORM ANALYST please have the following
available when calling technical support:

• Type and speed of Computer (Ex:  Dell or IBM or ‘generic PC’, Pentium II, Pentium III, or Cyrix,
etc.) and the total number of CPU’s (typically, only one).

• The operating system you are using (Ex: Windows ’98, Windows NT 4.0, Windows 2000,
Windows ME) and any applicable ‘service pack’ that has been installed (service pack 6 is
recommended for Windows NT 4.0 and service pack 2 is recommended for Windows 2000).

• The total amount of RAM installed on the computer

• The total amount of hard disk space, the file systems installed on each partition (Ex:  FAT16,
FAT32, NTFS) and the total amount of free space on all hard drives.

• The type of network connections (if any) and whether you are using a domain or a workgroup (for
Microsoft Networks).

• Any 3rd party programs that run continuously (such as FAX monitoring software, or an internet
client application such as ICQ), and any legacy or non-standard devices that still require entries in
either ‘CONFIG.SYS” or ‘AUTOEXEC.BAT’ to function.

• A printout of AUTOEXEC.BAT and CONFIG.SYS (when applicable – see above)

NOTE:  You can determine the current version and ‘service pack’ of a Windows operating system, as
well as RAM and CPU information, by running ‘Explorer’ and clicking ‘Help’ ‘About Windows’ – the
‘About’ dialog box will display useful system information that can aid in troubleshooting problems
installing and running Waveform Analyst.  Disk space and partition information can be obtained by
opening ‘My Computer’ and viewing the ‘properties’ dialog box for each disk drive on the computer.
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Operating Difficulties

If you are experiencing difficulties in operating WAVEFORM ANALYST, please have the following
available when calling technical support:

• Configuration setup of Analyzer

• Serial Number and Model Number of Analyzer

• The circuit configuration of the device (Ex:  WYE/DELTA)

• The type of database that the O.P.E.N. data is stored in (Ex: MS Access ‘.mdb’ file, SQL
Server).

• The name (and version) of the application that loads the data into the ‘O.P.E.N.’ database.
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Appendix B: Glossary of Terms

Database
A set of tables that stores information applicable to Waveform Analyst.  The database format used by
Waveform Analyst is called ‘O.P.E.N.’ and stores ‘node’ and ‘equipment’ configuration information, as
well as time-based ‘event’ and ‘waveform’ information on a per-node basis.

Dialog Box
A view that enables user interaction.  The Dialog box sends and receives information to the user via
buttons, and controls.

Event
A measurement associated with a single date and time, that has a value, a Measurement Parameter
(such as RMS VOLTS or AVERAGE CURRENT), a Trigger Condition (such as TIMED or NORMAL
TO LOW), and optional values (such as min/max and duration).

Waveform
A cyclic measurement associated with a starting date and time that has multiple values, a
Measurement Category (such as VOLTAGE or CURRENT), a Trigger Condition (such as TIMED or
NORMAL TO LOW), a frequency, a cycle count, and a duration.

ODBC Compliant Database
A database that conforms to the ODBC standard.

Pane
Another word for a section of a window.  Data is displayed in a pane which isolates that type of data.
For more information on panes please see Three Pane Browser.
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Site
A collection of Nodes associated with a specific circuit that includes the Monitoring Device as well as
its recording channels.  Where a Measurement Point is normally associated with the circuit being
monitored, a Site is normally associated with the monitoring device itself.

Analysis
A power quality survey that is associated with a specific circuit, or a set of Nodes from one or more
circuits.

Node
 A unique identifier that is usually associated with waveform and event data being collected from a
monitoring device.  A node has properties that include its location, its relationship to other nodes, the
type of equipment associated with it, and the type of data that is expected to be collected (if any).
Each piece of equipment in the O.P.E.N. database has a node associated with it.  There is a node
associated with the monitoring device itself, the circuit that the data is being collected for, and each
phase of the circuit.

Circuit
Also called a Measurement Point, a circuit refers to the points that the monitoring device is collecting
data for, and the wiring configuration associated with it.  Typically it will be a WYE or DELTA, with
voltage and current data being collected from the individual phases.
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Appendix C: PQ Analyst – Theory of
Operation

PQ Analyst uses a multi-threaded scheduler to automatically run reports, generate graphs, process
alarm/trigger notifications, and FTP and/or e-mail the output files to pre-determined destinations.

PQ Analyst will periodically check to see if any job needs to be run, and if it finds anything, it will
launch a new ‘thread of execution’ to process the job and update the next time/date when it is
complete.

The data for PQ Analyst is stored in two different ODBC data sources, appropriately named
‘PQAnalyst System’ and ‘PQAnalyst Data’.  The ‘PQAnalyst System’ database contains scheduling
information about devices, jobs, directory names, and other ‘system level’ information.  The
‘PQAnalyst Data’ database contains device configuration, event, and waveform data.  By default, this
data is stored in 2 MS Access database files, located by default in the C:\GE_PMCS\PQAnalyst\Data
directory, named ‘PQASystem.mdb’ and ‘PQAData.mdb’.

The output files for each job depend on the type of job being run, and the scheduling frequency.  For
month to date, quarter to date, year to date, and other ‘period end’ scheduling frequencies, the output
files will be placed into a directory that represents the period.  As an example, month to date data for
January will be placed into the ‘M01’ directory.  Other data, such as hourly and ‘trigger’ scheduling, is
placed into the ‘History’ directory upon successful upload (when applicable) to the FTP server.

Whenever PQ Analyst runs the Ai*Power application, it must export the data from the OPEN
database format into a format that Ai*Power can accept.  It must also ensure that more than one
application will not be attempting to print to the Adobe PDF Writer (when installed) at the same time.
To accomplish this, PQ Analyst will only run a single Ai*Power report at any given time.

PQ Analyst also uses a proprietary locking scheme to ensure that only one application can run a
given job at any time.  On occasions, a user may attempt to edit or view a job or device’s properties
and get a message box with an error message indicating that the job (or device) could not be ‘locked’.
This reflects the need by PQ Analyst to prevent changing a job or device’s properties while the job (or
device) has active jobs.

The basic logic flow is as follows:
1. PQ Analyst checks the list of jobs from the PQ Analyst ‘System’ database, and determines if

any of them need to run.
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2. If any are found, PQ Analyst creates a new ‘thread of execution’ to run the job, and then write-
locks the job’s entry in the PQ Analyst ‘System’ database.  This allows other processes to
read the entry, but no changes (or additional job schedules) can be performed on it.

3. The new job then gets added to the internal queue, and dependencies are assigned.  As an
example, an Ai*Power report might need to run, which requires that no other Ai*Power
reports are currently running.  Therefore, an Ai*Power report must wait until no other
Ai*Power reports are scheduled or running before it can run.

4. Once output files have been generated, their disposition is determined, and the files are sent to
their appropriate destination (FTP, e-mail) and copied to the appropriate history folder.

5. For FTP, if there are ANY files in the history folder that are newer than the ones on the FTP
site, they will be uploaded as well as the ones that were created by the report.

6. The job is unlocked and resources freed so that other operations can be performed on it.

Whenever a job is scheduled, PQ Analyst will run it at the exact time it is scheduled for.  Once
complete, the original scheduled date/time is used as the basis for determining when it needs to run
next, by adding the ‘schedule frequency’ to the original starting date/time.  So, if the schedule
specifies ‘240 minutes’ (4 hours), then 4 hours will be added to the original start time.  However, if the
new scheduled time were to precede the current time, or were to fall within a few minutes of the
current time (so that the same job would be repeating itself almost immediately), an additional amount
of time equal to the schedule frequency (in this case, 4 hours) would be added to the result until the
new scheduled date/time falls ‘reasonably after’ the current date/time.

Scheduler Log
The scheduler log output indicates the jobs that have run.  Dates and times are in GMT to prevent
daylight savings and time zone issues from affecting the analysis.  Warnings are highlighted in yellow,
and errors are highlighted in red, so that they may be easily spotted in the log.



PQ Analyst User’s Guide ••••  109

PMCS Device Compatibility Notes
EPM 3710, EPM 3720 and PQM devices are not supported by Waveform Analyst or PQ Analyst. The
specific waveform capture features of these devices (which permit user selection of channels) can
lead to incorrectly interpreted results.

SR 745 waveform data cannot be used to generate PQ reports. PQ reports require voltage channel
data and SR 745 devices only monitor current.

SR745 and Universal Relay devices support multiple sources, however the Waveform Analyst and
PQ Analyst assume one source per device by default. Manual intervention is required by the
Waveform Analyst user in order to select another source channel for viewing. Reference the section
"Manual Mapping" for instruction on how to select from several sources.
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